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Working with R - RStudio

RStudio is an Integrated Development Environment (IDE) for R

- Helps you write code - makes suggestions

- Helps you view the output of your code

- Helps you find errors

+ Is NOT a dropdown statistical tool (such as Stata)
- See Rcmdr or Radiant

@Studid

RStudio used to be the name of a company that is now called Posit.

[source]
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https://www.rstudio.com/
https://posit.co/
https://cran.r-project.org/web/packages/Rcmdr/index.html
http://vnijs.github.io/radiant/

RStudio

Easier working with R

+ Syntax highlighting, code completion, and smart indentation
- Easily manage multiple working directories and projects

More information

- Workspace browser and data viewer
- Plot history, zooming, and flexible image and file export
- Integrated R help and documentation
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RStudio

First it is important to be familiar with the layout. When you first open RStudio,
you will see 3 panes.

XX ) RStudio
QO -0r - - A Go to file/function - Addins - & New_Folder ~
Console  Terminal Background Jobs = Environment  History Connections  Tutorial —x

(R R4.2.2 - ~/Documents/ = BH #*Import Dataset ~ % 87 MiB ~ !’ List - -

R - 7} Global Environment ~

R version 4.2.2 (2022-10-31) -- "Innocent and Trusting"
Copyright (C) 2022 The R Foundation for Statistical Computing

Platform: x86_64-apple-darwinl7.@ (64-bit) Environment is empty
R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions. Pa ne 2

Type 'license()' or 'licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors. Files o o e P == E e Lo =0
Type 'contributors()' for more information and © |Folder © BlankFile + © Delete < Rename {} ~
'citation()" on how to cite R or R packages in publications. 4 Home - Documents

A Name Size Modified
Type 'demo()' for some demos, 'help()' for on-line help, or ry
'help.start()' for an HTML browser interface to help. -
Type 'q()' to quit R.

Pane 3

Pane 1
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Hidden Pane

To save a copy of your code. You must open a file first - this will open a 4th pane.
These files include Scripts or what are called R Markdown files.

-OR P H B = » Go to file/functi

R Script {+3N

1Y
y
|

Quarto Document...

Quarto Presentation...
12 R Notebook /
® R Markdown...
R Shiny V Create a new R Markdown document

Plumber API...

@
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Hidden Pane

You will see a popup that you can just say “OK” to for now.
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Hidden Pane

Nice! now we have a place to save code! This is where we will mostly be working.

Tools_for_Reproducible_Workflows_in_R - fstudio - RStudio

[+ : Go to file/function 5 - -~ Addins ~ % Tools_for_Reproducible_Workflows_in_R =

@ | Untitled1* = Environment History Connections Build Tutorial —(=
KnitonSave , Cf .& Knit - i@ - ~*Run » | G~ i # Import Dataset ~ % 99 MiB ~ & List ~ -

Source = Visual Outline R =~ 7} Global Environment ~

1 -
title: "Untitled"
author: "" Environment is empty
date: ""

output: html_document N ew Pa ne !

Pane 2

“""{r setup, include=FALSE}
knitr::opts_chunk$set(echo = TRUE)
Files Plots Packages Help Git Viewer Presentation = [

## R Markdown © Folder © BlankFile - © Delete . Rename & {J} -

/i\_ Home - Documents - Roger - New_Folder
A Name Size Modified

T .

This is an R Markdown document. Markdown is a simple formatting syntax for
authoring HTML, PDF, and MS Word documents. For more details on using R
Markdown see <http://rmarkdown.rstudio.com>.

Console  Terminal Background Jobs —[E=

R R4.2.2 . ~/Documents/Roger/Tools_for_Reproducible_Workflows_in_R/

Pane 3

R version 4.2.2 (2022-10-31) -- "Innocent and Trusting”
Copyright (C) 2022 The R Foundation for Statistical Computing Pane 1

Platform: x86_64-apple-darwinl?.® (64-bit) R
squished

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions. down

Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
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Working with R in R Studio - 2 major panes:

1. The Source/Editor: “Analysis” Script + Interactive Exploration
- Static copy of what you did (reproducibility)
- Top by default

2. The R Console: “interprets” whatever you type
+ Calculator
- Try things out interactively, then add to your editor

- Bottom by default
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Source / Editor

+ Where files open to

- Have R code and comments in them

+ Can highlight and press (CMD+Enter (Mac) or Ctrl+Enter (Windows)) to run the

code

In a .R file (we call a script), code is saved on your disk

[ JON ) ~/Dropbox/Packages/spant - master - RStudio

l-lex- 8B B2 6= i spant -

@] Untitled1 - Environment History Build Git -
Source on Save Q 7z -8 b . = <4 [l 4 Import Dataset ~ 3, List = ;‘1
i "} Global Environment -
Environment is empty
Files Plots Help Viewer -
@ New Folder = € | Delete [ Rename # More ~ ;—1
Q Home = Dropbox - Packages = spant I3
A Name Size Modified
t.
1:1 (Top Level) + R Script = ¥ .gitignore 46 B May 23, 2017, 1:32 PM
Console ~/Dropbox/Packages/spant/ ) - ] .Rbuildignore 189 B May 23, 2017, 1:32 PM
You are welcome to redistribute 1t under certain conditions. 7 .Rhistory 8.6 KB Jun 16, 2017, 2:42 PM
Type 'license()' or 'licence()' for distribution details. T @ travis.yml 3728 Jun 7, 2017, 12:02 PM
Natural language support but running in an English locale | m] cran-comments.md 2428 Jun7,2017, 12:02 PM
I data
R is C'l collgbor‘atlve'pr‘OJect wu':h many .contr'lbutor's. ) %9 DESCRIPTION 9528 Jun 16, 2017, 2:22 PM
Type 'contributors()' for more information and R
'citation()' on how to cite R or R packages in publications. [ inst
=l man
Type 'demo()' for some demos, 'help()' for on-line help, or — N )
'help.start()' for an HTML browser interface to help. B L] NAMESPACE 2.2 KB Jun 16, 2017, 2:22 PM
Type 'q()' to quit R. mo] NEWS.md 7328 Jun 16, 2017, 2:22 PM
@R
> _
l 55| README-basis_sim-1.png 41.9 KB Jun 16, 2017, 2:22 PM
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R Console

Qe

(]
ME= SN

3] Untitled1

~[Dropbox/Packages/spant - master - RStudio

= 0 to file/function S - [~ Addins -

(7] Environment History Build Git

- ~#Run | ®% | #Source ~ = <4 [ #Import Dataset ~ ¥

7% Global Environment ~

Source on Save

Environment is empty

Files Plots Help Viewer

@) New Folder '~ ©  Delete (| Rename = {gk More ~
4) Home = Dropbox = Packages = spant

4 Name Size
t.
R Script * 1 .gitignore 468
= - 1 .Rbuildignore 1898
You are w ©7] .Rhistory 8.6 KB
Type ) travis.yml 3728
mo] cran-comments.md 2428
~ O data
Rlis a cotlaborative project with many contributors. 1 ) DESCRIPTION 9528
TYpe 'contributors()' for more information and
. ) inst
=) man
Type -
*help. ] NAMESPACE 2.2 KB
Type "q0) ne] NEWS.md 7328
&R
> S| README-basis_sim-1.png 41.9 KB

- Where code is executed (where things happen)

- You can type here for things interactively to test code

-+ Code is not saved on your disk

£ spant -

=

List » |

Modified

May 23, 2017, 1:32 PM
May 23, 2017, 1:32 PM
Jun 16, 2017, 2:42 PM
Jun 7, 2017, 12:02 PM
Jun 7, 2017, 12:02 PM

Jun 16, 2017, 2:22 PM

Jun 16, 2017, 2:22 PM

Jun 16, 2017, 2:22 PM

Jun 16, 2017, 2:22 PM

|

&
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RStudio

Super useful “cheat sheet”: LINK

Write Code

Mavigate Openinnew Save Findand Compileas Run

R Support

Importdata Historyofpast  Display .RPres slideshows

tabs window replace notebook  selected with wizard commandsto  File> New File >
: o code 1 lrun,fcnp}.f R Pm_sentatinn
@ File _:';ﬂl: m.l_.-"-u\w Paaits: s-mnu- Build ___n';img Toals mlp‘ ’ [ garreit (= Sessions= ] @
t?:;" g. i furct H- L. s ; b DEchearshees » R 3237 -
@ mmﬁ.nm.d"‘ #jappk = 9] s_;fi;.: = =1 Environmest m-m Suikd it Presesiation = =0
5 ] || Source on Save CL Ll .I _-th_il:[___ te | SEUTEE = & i.].__ﬁ'fmwrrbmmt— }'___. Umte | (B
1 |# Good Start. | R E -?cunw:n;;-'&r'.;;.'.;.}::--.,_l T
2 : Cursors of Re-run " Source with or  Show file | Load i Save Delete all Search inside i :
i “shared users  previous code  without Echo  outline workspace iworkspace saved objects  environment . ;
I — Multiple cursors/column selection Chaose environment to display from Display objeéts
6 "PB@3sac1” with Alt + mouse drag. list of parent environments aslistor grid
7 "Pad3aaaz” ded h h Data
i "P@@ICA01” Code diagnostics that appear in the margin. =~ " .
9 “pe@3eses” Hoveroverdiagnostic symbols for details, | 1™ e i
10 e . . X a 1
n Syntax hﬁhlllghtmg based | o tions
e gEt_dig'i.t < function() { On your Tile s extension foo function (x)

£13  ("num” %% (18 A n)) Tab completion to finish
b14 wEQBA(M-1) L function names, file paths,

'3:: H e arguments, and maore.
17 fo L Multi-language cade
i; ' snippets to quickly use
2 | force - commoen blocks of code.
21 Jump to function in file Change file type
2z :

Ll (Top Level £ R Seript £
Consele  Compile POF « R Markdown » _!_:
IDEcheatsheet, 2 om,.,

’E,l{u;(n T Working Maximize,
s | Foo <= function{x} x + 1 Directory minimize panes
2

Press 4 to see Drag pane -
command history  boundaries

Displays saved objects by Viewin data View function

type with short description viewer source code
Files  Flots  Packages Help  Viewer =1
Qb Folder 9 Ugload | @ Delete (= Rerame (¥ More -
I Home | IDEcheathest Cony.. -
= hame | Mo, !
: H : : Export...

Create | Upload Delete Rename | seasworungorsann| Change
folder | file file file fin To Warking Deecteny] directory

Path to displaved directory
t .

21 hello.R 158 Apr 13, 2006, 11:17 AM

A File browser keyed to your working directory.
Click on file or directory name to open.
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https://raw.githubusercontent.com/rstudio/cheatsheets/main/rstudio-ide.pdf

R Markdown files look different form scripts

It will look like this with text in it, unlike a script.

[ NON ) intro_to_r - rstudio - RStudio
LI+ ) - i1 B A Coto file/ function E - = Addins = £l intro_to_r =
I= Untitledl = Envireonment Histery Connections Build Git  Tuterial = ]
H Y S| o Knit - - *[ insert = =+ Rkun = | ‘- = = =+ 4 # Import Dataset = | & List = -
1 - 7} Global Envirenment =
2 title: "first_morkdown"
3 owtput: html_document
4 -
5 Environment s empty
6~ T {r setup, include=FALSE} ¥
7 knitr::opts_chunkiset{echo = TRUE}
ga o
9
18 = #& R Morkdown
11
12 This is an R Markdown document. Markdown is o simple formotting syntox for
authoring HTML, PDF, and M3 Word documents. For more detoils on using R
Markdown see <http.//rmorkdosn.rstudio. coms. Files Plots Packages Help Viewer = ]
13 O Wew Folder | © Delete = Rename | {JF More -
14  When vou click the **Enit** button a document will be generated that includes — "
both content as well as the output of any embedded R code chunks within the LI a7 Home - Documents - GitHub — Teaching - intra_to_r
document. You con embed on R code chunk like this: = LV Size Modified
17 Tt .
16= """{r carsk . - -
223 | @ frst_markdown 3 R Markdown : | — ‘¥ .gitignore 245 8 May 18, 2021,
Ll Rbuildignore 16 B May 18, 2021,
Console  Terminal Jobs = ] -
Ll Rhistory 43 B Jum 10, 2021,
= Documents / GitHub Teaching fintro_te_ry . )
T T A e T e e S R R S T T S R T G R ST ) m eravis.yml GEG B Jum 9, 2021,
Type "license(}’ or 'licence()" for distribution details. 0 all_functions.xlsx 13.4 KB Jun 8, 2021,
Matural language support but running in on English locale o all_the_functions.csv 57.3KE Jum &, 2021,
[ all_the_packages.txt Z211E May 18, 202
R is o collaborative project with mony contributors. O )
Type '"contributors()' for more informotion ond B Arrays_Spiit
‘citotiond)' on how to cite R or R packoges in publications. Ll Basic_R
] Best Model Coefficients.csy LETER May 18, 202
Type 'demo()' for some demos, “help()® for on-line help, or . - - _ ¥
'help.start{)" for an HTML browser interface to help. U Best_Made|_Coefficients.xlsx J.EKE May 18, 202
Type 'q()' to quit R. [ bibliography.bib 530 B May 18, 202
N [C1 =" black_and_white_theme.pdf 45.1KE May 18, 202
M B hinnmbaes lnan small barisan IC A VD Maws 1@ 3N
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Recall that a script was just empty

0@
l-lex- B B oa % spant ~

~/Dropbox/Packages/spant - master - RStudio

37 Untitled1
Sourceon Save = & /-

1:1 (Top Level) =

Console ~/Dropbox/Packages/spant/

You are welcome to redistribute 1t under certain conditions.

Type 'license()' or 'licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and

'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

> |

R Script =

=

Environment History Build Git |
=4 [ #Import Dataset + = 3" List » (=
"} Global Environment -
Environment is empty
Files Plots Help Viewer -]
@ New Folder | € | Delete (| Rename = ik More ~ 5
/.\ Home ~ Dropbox ~ Packages ~ spant R
A Name Size Modified

t.

] .gitignore 46 B May 23, 2017, 1:32 PM
- 1 .Rbuildignore 189 B May 23, 2017, 1:32 PM
| ] .Rhistory 8.6 KB Jun 16, 2017, 2:42 PM
) ) .travis.yml 372B Jun 7,2017, 12:02 PM
| mo] cran-comments.md 242 B Jun 7,2017, 12:02 PM
)l data
| 7 DESCRIPTION 952 B Jun 16, 2017, 2:22 PM
1 inst
1 man
1 ] NAMESPACE 2.2 KB Jun 16, 2017, 2:22 PM
1 mo] NEWS.md 732 B Jun 16, 2017, 2:22 PM
) @eR
| = README-basis_sim-1.png 41.9 KB Jun 16, 2017, 2:22 PM
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Scripts and R Markdown

Although people will use scripts often, and they are good for more programmatic
purposes, we generally don't recommend them for Public Health Researchers.

For data analyses, R Markdown files are generally superior because they allow
you to check your code and write more info about your code.
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Workspace/Environment

[ JON ) ~/Dropbox/Packages/spant - master - RStudio

Ql-lcs- 6B B %v o=l ~| Addins ~ i spant ~
@] Untitled1 | Envibnment History Build Git [
a1 | 3 SourceonSave = O /- i | - ~#Run %% | “Source =~ /7 |- Import Dataset + | 3" ist ~ | (=
1 | "} Global Environment -
Environment is empty
Files Plots -]
@ New Folder € | Delete (| Rename = ik More ~ s
/.\ Home ~ Dropbox ~ Packages ~ spant R
A Name Size Modified
t.
1:1 (Top Level) = R Script = ¥ .gitignore 46 B May 23, 2017, 1:32 PM
Console ~/Dropbox/Packages/spant/ iy =) - 1 .Rbuildignore 189 B May 23, 2017, 1:32 PM
You are welcome to redistribute 1t under certain conditions. ] .Rhistory 8.6 KB Jun 16, 2017, 2:42 PM
Type 'license()' or 'licence()' for distribution details. T travis.yml 3728 Jun 7, 2017, 12:02 PM
Natural language support but running in an English locale | m] cran-comments.md 2428 Jun7,2017, 12:02 PM
)l data
R is t'z collgbor‘atlve'pr‘OJect w1.t':h many @ntr‘lbutor‘s. 1 #9 DESCRIPTION 9528 Jun 16, 2017, 2:22 PM
Type 'contributors()' for more information and R
'citation()' on how to cite R or R packages in publications. [ inst
] man
Type 'demo()' for some demos, 'help()' for on-line help, or — N )
'help.start()' for an HTML browser interface to help. B LJ NAMESPACE 2.2 KB Jun 16, 2017, 2:22 PM
Type 'q()' to quit R. mo] NEWS.md 7328 Jun 16, 2017, 2:22 PM
O @R
> .
l 55| README-basis_sim-1.png 41.9 KB Jun 16, 2017, 2:22 PM
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Workspace/Environment

- Tells you what objects are in R

-+ What exists in memory/what is loaded?/what did | read in?

History

- Shows previous commands. Good to look at for debugging, but don’t rely on
it.
Instead use RMarkdown!

- Also type the “up” key in the Console to scroll through previous commands
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Other Panes

- Files - shows the files on your computer of the directory you are working in
- Viewer - can view data or R objects

- Help - shows help of R commands

- Plots - pictures and figures

- Packages - list of R packages that are loaded in memory
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RStudio Layout

If RStudio doesn't look the way you want (or like our RStudio), then:

Click on the pane button, which looks like a waffle with 4 indentations. Scroll
down to “Pane Layout”.

® O
CE QR ™ = #» Go to file/function ~  ~ Addins ~
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Default Layout

Options

LT; General
= Code
> Console

-ﬂ Appearance
~ Pane Layout
| Packages

R Markdown

!’ Python

@ sweave

ABC

v Spelling

W Git/suN

"5;- Publishing

- Terminal

6 Accessibility

Choose the layout of the panels in RStudio by selecting from the controls
in each panel. Add up to three additional Source Columns to the left side
of the layout. When a column is removed, all saved files within the column

are closed and any unsaved files are moved to the main Source Pane.

& | Add Column

| Source

| Environment, History, Connections, v

V| Environment

V| History
Files
Plots

| Connections
Packages
Help

V| Build
VCSs

| Console

Files, Plots, Packages, Help, VCS, v |

Environment
History
V| Files
V| Plots
Connections
| Packages
v/ Help
Build
v/ VCS

OK Cancel Apply
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Let's take a look at R Studio
ourselves!



Lab: Starting with R and RMarkdown
0 RStudio Lab

To do this lab we need to:

-+ Download the file at the link above by clicking on it or go to the website
schedule page

- Find the downloaded file on your computer
+ Open the file in RStudio (double clicking the file name typically works)

These videos can help if you aren’t sure where your downloads are:
If you have a PC: https://youtu.be/webvwB7DsNU
If you have a Mac: https://www.youtube.com/watch?v=Ao09e0cDzMrE

You can find these on the resource page of the class website.
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https://daseh.org/modules/RStudio/lab/RStudio_Lab.Rmd
https://youtu.be/we6vwB7DsNU
https://www.youtube.com/watch?v=Ao9e0cDzMrE
https://daseh.org/materials_schedule.html

R Markdown file

R Markdown files (.Rmd) help generate reports that include your code and
output. Think of them as fancier scripts.

1. Helps you describe your code
2. Allows you to check the output
3. Can create many different file types
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Create an R Markdown file

Go to File - New File - R Markdown or click the green add file button.

5 CEFTINIE

@ R Script 3N

ng_with_
= R Motebook & Kni

2 R Markdown...

=
.4

Mgt |

Shiny Wek AR cate a new R '
@ Plumber APL. parkdown

 document k

Taxt File :
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Code chunks

Within R Markdown files are code “chunks”.

This is where you can type R code and run it!

e cars} .

summary( cars ) Files Plots

fﬂun Eurr&nt Chunk g
eE—

. ] #3%
- ## Including Plots _| {at Home

& Man
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Run code in a chunk
Clicking the run (play) button runs the code in the chunk.

P cars) =k

summary [ cars )

Files Flots

fﬂun Current Chunk E
=L
] {3 Home

& Man

#¢ Including Plots

Ctrl + Enter on Windows or Command + Enter on Mac in your script
evaluates that line of code
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Running a chunk executes the code

- generally see a preview of the output of the code just below the chunk
- see the code in the console
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If you get annoyed by code previews in Markdown files...

See the Help page of the website. You can adjust this and change your RStudio
settings:

Tools > Global Options > R Markdown

27145


https://daseh.org/help.html

Knit file to html

Running all chunks - this will create a report from the R Markdown document!

0@

O -8 - W R

— & Coto file/function

= | Untitled1

H Y A ekt - . '

;I & Knit to HTML
= Knit to PDF
4 W Knit to Word

Knit with Parameters...

k Knit Directory LS

,f Clear Knitr Cacha...
#& R Morkdown

This 15 an B Markdown document. Morkdown is
authoring HTML, PDF, and M3 Word documents.
Markdown see =htto: Yrmaorkdown.estudio. coms
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Nice report!

This generates a nice report that you can share with others who can open in any

browser.
L NN
Untitled.html Open in Browser Find

Untitled

Your Name
2023-03-29

R Markdown

This is an R Markdown document. Markdown is a simple formatting syntax for authoring HTML, PDF, and MS Word documents. For more details

~/Documents/Roger/New_Folder/Untitled.html

on using R Markdown see http://rmarkdown.rstudio.com.

When you click the Knit button a document will be generated that includes both content as well as the output of any embedded R code chunks

within the document. You can embed an R code chunk like this:

summary(cars)

speed

A

## Min. : 4.
## 1st Qu.:12.
## Median :15.
## Mean :15.
## 3rd Qu.:19.
## Max. :25.

o o & O O O

dist
Min. : 2.
1st Qu.: 26.
Median : 36.
Mean : 42,
3rd Qu.: 56.

Max. :1120.

Including Plots

You can also embed plots, for example:

00
00
00
98
00
00

“5, Publish ~
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Create Chunks

To create a new R code chunk:

Use the insert code chunk button at the top of RStudio.

@ RStudio.Rmd ]
- A KnitonSave |, (O & Knit -  ~ o - #Run ~ | ‘5. ~

Source Visual / = Outline

Select R (default) as the language:

-|- -

| R \
Bash e

D3
Python
Recpp
SQL

Stan

(@

e®mEP®eE
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Create Chunks
If you like keyboard shortcuts:

- Windows & Linux use Ctrl+Alt+]

+ Mac use Command+Option+l

| is for insert.
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Run previous chunks button

You can run all chunks above a specific chunk using this button:

U r, out.width = "8@%", echo = FALSE, fig.align='center'} =
knitr::include_graphics("images/chunk.png") T
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Chunk settings

P

Please click here to update the s

_— F
Chunk Name: |[Jnnamed chunk
Output: ' Show output only =

(LD Show warnings

(L D) Show messages

([ 1) Use paged tables

(J) Use custom figure size

7' Chunk options

Rewert

Apply

red t

e le

LI s |

g Ut Home

Documents  GitHub
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Chunk settings

You can specify if a chunk will be seen in the report or not.

Please click here to update the

| h
. - rec
Chunk Name: |Unnamed chunk |
Qutput: ' Show output only v e
() Show wary_(Use document default)
Show output only

©D Show mes Show code and output -~
(L) Use paged show nothing (run code) =
(1) Use custol Show nothing (don't run code) o

?) Chunk options VTR RERIY-

a | |t Home Documents GitHub = Tea
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Errors

R studio can help you find issues in your code. Note that sometimes the error

occurs earlier than RStudio thinks.

305 print(x, ...)
306~ " {rf

0307 print(x))|

3
3
3

o A -~

unexpected token ')'
unexpected end of document
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Rainbow Parentheses

Tools —> Global Options -> Code -> Display —> Use rainbow parentheses

Press enter to save this setting and get out of this menu.

LCCCCCLLETELLELLLE Enjoy your colorful code! J1111135535300)0).
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Useful R Studio Shortcuts

+ Ctrl + Enter on Windows or Command + Enter on Mac in your script
evaluates that line of code

- It's like copying and pasting the code into the console for it to run.
+ Ctrl+1 on Windows or Command + 1 on Mac takes you to the script page
+ Ctrl+2 on Windows or Command + 2 on Mac takes you to the console

http://www.rstudio.com/ide/docs/using/keyboard_shortcuts
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http://www.rstudio.com/ide/docs/using/keyboard_shortcuts

Recap of where code goes

you can test code in the console

Console Terminal Render Background Jobs

R R4.2.2 . ~/Documents/GitHub/Teaching/intro_to_r/

>
> class(iris)

you can save code in a chunk in the editor (Markdown file)
## R Markdown

Code does not go here and instead goes within the grey chunks like this:

““{r} =z

summary(cars)
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Getting help from the preview

When you type in a function name, a pop up will preview documentation to help
you. It also helps you remember the name of the function if you don't remember

all of it!

2 The'

> class haser | class(x) n

> B class Object Classes i

> -~

] class<- {base} |Rpossesses asimple generic function mechanism which can be \
used for an object-oriented style of programming. Method {

1 classesToAM {methods} dispatch takes place based on the class of the first argument to the

> @ classlInt:: generic function. |

7 classLabel {methods}t | Press F1 for additional help I

> -

] classMetaName  {methods} Main

> class —— Othe

> The 'tidyverse

7 read_builtin {readr} |read_csv(file, col_names = TRUE, col_types = NULL, :a

> . col_select = NULL, id = NULL, locale = n

d_chunk knit - . ’

> reac_chtin tknitr} default_locale(), na = c("", "NA"), quoted_na = m

, ~ read_csv {readr} TRUE, quote = "\"", comment = "", trim_ws = TRUE, aC

> read_csv2 {readr} skip = @, n_max = Inf, guess_max = min(1000, 2’

SIS d 2 chunked d n_max), name_repair = "unique", num_threads =

N read_csve_chunke ireadr} readr_threads(), progress = show_progress(),

g read_csv_chunked {readr} show_col_types = should_show_types(),

, ¢ read_delinm {readr} | press Fl foraddiionalhelp 7 77 H

> read_| Other contribu
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Get help with the help pane
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Getting Help with ?

If you know the name of a package or function:

Type ?package_name or ?function_name in the console to get information

about packages and functions.

For example: ?readr or ?read_csv.

Console  Terminal Render Background Jobs — ]

R R4.2.2 - ~/Documents/GitHub/Teaching/intro_to_r/

7class

VV V V V YV V VYV YV V VYV Y VVVY YV VVYVYVYV

Files Plots Packages Help Git Viewer Presentation -

\,—‘L\/Q’

R: Object Classes ~  Find in Topic

class {base} R Documentation

Object Classes

Description

R possesses a simple generic function mechanism which can be used for an
object-oriented style of programming. Method dispatch takes place based
on the class of the first argument to the generic function.

Usage

class(X)

class(x) <- value

unclass(x)

inherits(x, what, which = FALSE)
isa(x, what)
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Double Question Mark

If you haven't loaded a package yet into R than you may get a response that
there is no documentation.

Typing in ??package_name can show you packages that you haven't loaded yet.

Console Terminal Render Background Jobs = M
R R4.2.2 . ~/Documents/GitHub/Teaching/intro_to_r/ Files Plots Packages Help Git Viewer Presentation —l
>
S R Q : |
S R: tidyverse: Easily Install and Load the 'Tidyverse' ~  Find in Topic
: tidyverse-package {tidyverse} R Documentation
>
o tidyverse: Easily Install and Load the
> ?class
1 H 1
> 7tidyverse T|dyverse
No documentation for ‘tidyverse’ in specified packages and libraries:
you could try ‘??tidyverse’ Description
> ?7tidyverse
> library(tidyverse) The 'tidyverse' is a set of packages that work in
— Attaching packages tidyverse 1.3.2 — harmony because they share common data
v ggplot2 3.4.0 v dplyr 1.0.10 representations and 'API' design. This package is SR s e’
v tibble 3.1.8 v stringr 1.5.0 designed to make it easy to install and load multiple Pty eett ity
s tidyr 1.2.0 , forcats 0.5.1 ‘tidyverse' packages in a single step. Learn more about tldyverse
v purrr 1.0.0 the 'tidyverse' at https://www.tidyverse.org. SR e et
— Conflicts tidyverse_conflicts() —

x dplyr::filter() masks stats::filter(Q) Author(s)

% dplyr::lagQ) masks stats::1lagQ)
> ?tidyverse
>

Maintainer: Hadley Wickham hadley@rstudio.com

Other contributors:
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Summary

+ RStudio makes working in R easier

- the Editor (top) is for static code like scripts or R Markdown documents

+ The console is for testing code (bottom) - best to save your code though!
- R'markdown documents are really helpful for lots of reasons!

R code goes within what is called a chunk (the gray box with a green play
button)

+ Code chunks can be modified so that they show differently in reports
0 Class Website

0 Lab

Image by Gerd Altmann from Pixabay
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https://daseh.org/
https://daseh.org/modules/RStudio/lab/RStudio_Lab.Rmd
https://pixabay.com/users/geralt-9301/?utm_source=link-attribution&utm_medium=referral&utm_campaign=image&utm_content=812226
https://pixabay.com//?utm_source=link-attribution&utm_medium=referral&utm_campaign=image&utm_content=812226

Extra Slides



Sometimes you want to hide your code

If you want to keep your code so people can see it if they want to there is a nice
option called code folding - check it out here:

https://stackoverflow.com/questions/69326576/show-output-but-hide-code-
when-sending-rmd-to-other-people
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https://stackoverflow.com/questions/69326576/show-output-but-hide-code-when-sending-rmd-to-other-people

